
 
 
 

  RECORDNOW MAX 4.0 USER’S GUIDE  
 
 
PLEASE RECORD RESPONSIBLY.  BEFORE COPYING ANYTHING ONTO A CD OR DVD 
DISC, PLEASE BE SURE YOU ARE NOT VIOLATING COPYRIGHT LAWS.  MOST 
SOFTWARE COMPANIES ALLOW YOU TO MAKE A BACK-UP OR ARCHIVE COPY OF 
SOFTWARE.  CHECK YOUR SOFTWARE LICENSE AGREEMENT FOR SPECIFIC DETAILS.  
CONTACT YOUR LEGAL ADVISOR IF YOU ARE UNSURE OF YOUR RIGHTS. 
 
Copyright notice: © 2002 Stomp Inc.  These computer programs are protected by copyright law 
and international treaties. Unauthorized reproduction or distribution of this program, or any portion 
of it, may result in severe civil and criminal penalties. 
 
Pentium is a trademark of Intel Corporation, DLA, RecordNow MAX are trademarks of Veritas 
Software Corporation.  Windows 95, 98, Me, 2000, NT, and XP are trademarks of Microsoft 
Corporation.  
 
 
CDDB is a registered trademark of Gracenote.  CDDB, the Gracenote logo, the Gracenote CDDB 
Logo, Meta-Database and the Gracenote Logo are trademarks of Gracenote.  Music Recognition 
Service and MRS are service marks of Gracenote. 
 
Portions based upon Microsoft Media Technologies. Copyright (c) 1999 Microsoft Corporation. All 
Rights reserved. 
 
MPEG Layer-3 audio compression technology licensed by Fraunhofer IIS and THOMSON 
multimedia. 
 
Other trademarks are the property of their respective owners. 
 



INTRODUCTION 
 
Thank you for choosing Stomp RecordNow MAX!  RecordNow MAX is a simple-to-use yet 
powerful CD/DVD creation application that easily performs all your CD/DVD burning needs 
including:  
 

• Perfect Disc-to-Disc Copies 
• Burning Music CDs that will play in your car or home CD player from MP3, WAV, WMA, 

tracks from other CDs, or live recording through your sound card 
• Burning Data CD-ROM and DVD-ROMs for sharing large files 
• Video CDs & DVDs from your authored video files 
• Mixed Mode, CD Extra, and Bootable CDs 
• Unlimited MP3 ripping (96 ~ 320Kb/sec bit rates) 
• Simultaneous recording using up to 64 CD burners or 16 DVD burners at once 
• Clone CDs to hard disk for later copying 
• Drive Letter Access (DLA) software for formatting CD-R/RW, DVD-RAM, and DVD+RW 

discs like big floppy discs for drag and drop recording of files and folders. 
• And much more. 
 

This manual will assist you in the installation of the RecordNow MAX software.  There is also 
online help within the RecordNow MAX software. 
 
NEW FEATURES IN VERSION 4.0 
 
RecordNow MAX version 4.0 is better than ever!  Here’s what’s new: 
 

• Fresh new interface!  The RecordNow MAX Full Application has a bold new interface 
that’s even easier to use and more flexible. 

• Enhanced MP3 ripping!  Now rip at up to 320Kb/sec bitrates. 
• Launcher for DVD Video Authoring!  If you have DVD Authoring software installed in your 

system from MedioStream  or Cyberlink, a “DVD Video” button will appear on the Full 
Application’s toolbar for easy one-button launching of your DVD Video Authoring 
software. 

• Enhanced Bootable CD support!  RecordNow MAX can now create bootable CDs from 
floppy boot images, or a boot image on your hard drive. 

• Section 508 compliant!  Access for persons with disabilities 
 
 
SYSTEM REQUIREMENTS 
 

• 200MHz Pentium or faster (or equivalent) processor 
• 32MB of RAM 
• 25MB of available hard disk space for software installation.  Up to 5GB hard disk space 

required for mastering DVD discs. 
• Supported CD/DVD recorder (for a current list please visit www.stompinc.com/support) 
• Blank CD/DVD Recordable media 
• Microsoft Windows 95, 98 SE, Windows 2000 Professional, Windows Millennium, 

Windows NT 4.0 service pack 4 or higher, Windows XP  
• Internet access strongly recommended 
 

 



STOMP’S TECHNICAL SUPPORT POLICY 
 
Stomp provides unlimited telephone technical support for 30 days without charge.  The 30 day no 
charge support period begins from the first time you call our technical support department.  After 
the 30 day no charge period has expired, telephone support is available for a nominal charge of 
$20 per incident (not per call).  Web based support is available without charge and is unlimited for 
the life of the product. 
 
GETTING TECHNICAL SUPPORT 
 
Stomp is committed to customer satisfaction.  If you encounter problems installing or using any of 
the applications in RecordNow MAX, please do the following: 
 

• Check the trouble-shooting section in this manual.  
• Visit www.stompinc.com/support.  You can view FAQ’s, check for updates, and view the 

device support list, download manuals, and more. 
• If you would like to contact Stomp via telephone, please call 949-515-5299 Monday ~ 

Friday 8AM ~ 5PM PST.  Please be at the computer where the software is installed when 
you call. 

• If you would like to receive on-line support, please visit www.stompinc.com/support and 
click on the “Support Request Form”.  Once you submit this form, you will be contacted 
by Stomp via email within 2 business days. 

 
 

 
INSTALLING RECORDNOW MAX 
 

• Insert the RecordNow MAX CD-ROM into any available CD/DVD drive. 
• If Autorun is enabled on your system, the RecordNow MAX browser will automatically 

launch. 
Should the installer fail to load, double click on My Computer in Windows.  Double click 
on the icon of the drive that has the RecordNow MAX CD inside.  Double click on the 
Setup.exe icon to manually launch the RecordNow MAX browser. 

• Select RecordNow MAX and then click on the “Install Now” button to begin installation. 
 
Note: When installing neoDVDstandard, you will need the CD key.  It is printed on the envelope 
the RecordNow MAX CD-ROM came in 
 
 



Getting Started With The RecordNow MAX Wizard 
 
Now that you have successfully installed Stomp RecordNow MAX software, you are ready to 
begin burning CDs and DVDs.  When you launch the Stomp RecordNow MAX software, you 
will be presented with the RecordNow MAX Wizard.  This is the simplest way to perform the 
most commonly used CD/DVD burning tasks such as making and exact copy of a CD or 
DVD, making a music CD from MP3/WAV/WA files/CD tracks, or making a data CD-
ROM/DVD-ROM.   
 

 
 
 

If you are an advanced user and would prefer to use the full application, click on the Return to 
Stomp RecordNow MAX button and this will launch the full application.  
 
Making an Exact Copy of a CD/DVD with the RecordNow MAX Wizard 
 
TIP: Generally, it is not possible to copy commercial DVD movies as most of them employ CSS 
(Content Scramble System) copy protection.  DVD Video discs that you create yourself using 
neoDVDstandard can be copied freely as they do not have any copy protection.  Additionally, 
many commercial DVD movies are larger than blank DVD-R/RW/DVD+RW discs because they 
are double layer DVD9 discs.  The bonus materials on a DVD movie are generally the reason for 
the large disc. 
 
The Exact Copy feature makes a bit-for-bit identical duplicate of your original CD or DVD. 

• Launch Stomp RecordNow MAX Wizard 
• Click Make an Exact Copy.  The wizard will automatically open your CD/DVD drive tray 
• Insert the disc you are copying into the recorder’s tray and close the drive 
• Click on Next.  The software will begin reading the disc.   
 



 
 

Note:  In a system where you have only a single CD/DVD drive, you must wait until the 
software has completed copying the data from the original disc to a temporary area on 
the hard drive.  When it has completed this task, the tray will open and prompt you to 
remove the original disc, replacing it with a blank recordable disc. 

 
• Insert a blank disc into your CD/DVD recorder and click Next 

 

            
 

• RecordNow MAX will make an exact copy of your disc and inform you when the process 
is complete. 

• If you wish to only make one copy click on Done.  If you wish to make another duplicate 
copy click on Make Another and you will be prompted to insert another blank disc into 
the CD-Recordable drive. 

 
 



Making a Music CD Compilation with RecordNow MAX Wizard 
RecordNow Wizard easily creates custom music CDs or MP3 CDs from your music collection on 
your hard disk drive or your CD collection.  
To make a music CD from the Stomp RecordNow MAX Wizard click on Make a Music Disc.  You 
will then be presented with a new screen with the following options: 

• Make a Music Disc from Audio Files 
• Make a Music Disc from other CDs 
• Make a Disc for an MP3 Player 
 

 
 
 



Making a Music Disc from Audio Files 
This Option allows you to take the audio files stored on your hard drive and burn them on to CD 
 
To make a music CD from audio files: 

• Launch the Stomp RecordNow MAX Wizard 
• Click on Make a Music Disc 
• Click on Make a Music Disc from Audio Files.  The RecordNow Wizard automatically 

opens your CD/DVD recorder’s tray. 
• Insert a blank disc into the tray and click Next 
• Stomp RecordNow MAX Wizard will present you with an option to automatically scan 

your hard drive for music files.  Click Yes if you would like Stomp RecordNow MAX to find 
all your audio files. You may also scan for music by clicking the Scan for Music button 
that appears at the top of the leftmost window.  To be sure a music track is the one you 
want, you can click on a file on the left side of the window and click the speaker icon to 
play the file. 

 

 
 
 

• Select the tracks you want to add to your music CD as follows: 
You can add a track from the leftmost window “Music on System” to the layout, by 
highlighting the track and then clicking Add.  You can also click and drag a track to the 
layout. 
You can remove any track from the right hand pane by highlighting the track and clicking 
the Remove button.   
You can arrange the order of the tracks on the play list either by: 
- Highlighting the track you want to move and clicking on the green up or down arrows 
- Dragging the files to the desired position within the play list. 
You can re-name the tracks on the play list by selecting the track and then single clicking 
twice on the name. Type in the new name you desire and press Enter 

• Click Next to begin recording your tracks.  When Stomp RecordNow MAX has completed 
recording it will automatically eject the CD. 
If you wish to make another copy of your favorite compilation insert a blank CD into the 
recorder and click Make Another. 

• Click Done when you are finished recording. 
 



 
Making a Music CD from other CDs 
This option allows you to make a compilation CD from your collection of music CDs 
 
To make a music CD from other CDs: 

• Launch the Stomp RecordNow MAX Wizard 
• Click on Make a Music Disc 
• Click on Make a Music Disc from other CDs.  The RecordNow Wizard automatically 

opens your CD-Recordable drive 
• Insert a music CD into the CD-ROM/DVD-ROM drive and press Next 
 

 
 

• Select the tracks you want to add to your music CD as follows: 
You can add a track from the leftmost window titled “Music CD Tracks” to the layout by 
highlighting the track and then clicking Add.  You can also click and drag a track to the 
layout. 
You can remove any track from the right hand window by highlighting the track and 
clicking the Remove button.   
You can arrange the order of the tracks on the play list either by: 
- Highlighting the track you want to move and clicking on the green up or down arrows 
- Dragging the files to the desired position within the play list. 
You can re-name the tracks on the play list by selecting the track and then single clicking 
twice on the name. Type in the new name you desire and press Enter. 

• Click Next CD to add tracks from another CD.  RecordNow Wizard prepares your tracks 
and then prompts you to insert another CD.  This process may take a few minutes. 

• Insert the next CD you wish to copy tracks from and repeat the process for adding tracks. 
• Click the Finish button when you have completed making your compilation CD.  
• Insert a blank CD into the recorder’s tray and click Next.  RecordNow Wizard records 

your tracks to the blank CD. 
If you would like to make another copy of your music compilation, remove the newly 
recorded CD from the recorder’s tray and insert another blank CD disc, then click Make 
Another. 

• Click Done when you have finished recording. 
 
 



Making a Disc for an MP3 Player 
This option allows you to make a CD of MP3s that will be playable in CD players that support 
playing MP3 files on CD.  MP3s are compressed files and you can fit almost 10 times as many 
songs on a single CD.  This MP3 CD will not be playable on standard CD players, only those CD 
players that support playing of MP3 CDs. 
 
To make an MP3 disc: 

• Launch the Stomp RecordNow MAX Wizard  
• Click on Make a Music Disc 
• Click on Make a Disc for an MP3 Player.  The RecordNow Wizard automatically opens 

your CD-Recordable drive 
• Insert a blank disk into your CD-Recorder and click Next 
• Click Scan for Music to scan your hard drive for valid MP3 files 
 

 
 

• Select the tracks you want to add to your music CD as follows: 
You can add a track from the leftmost window titled “Music on System” to the layout by 
highlighting the track and then clicking Add.  You can also click and drag a file to the 
layout. 
You can remove any track from the right hand pane by highlighting the track and clicking 
the Remove button.   
You can arrange the order of the tracks on the play list either by: 
- Highlighting the track you want to move and clicking on the green up or down arrows 
- dragging the files to the desired position within the play list. 
You can re-name the tracks on the play list by selecting the track and then single clicking 
twice on the name. Type in the new name you desire and press Enter. 

• Click Next to begin recording your tracks. 
If you would like to make another copy of your music compilation, remove the newly 
recorded CD from the recorder’s tray and insert another blank CD disc, then click Make 
Another. 

• Click Done when you have finished recording. 
 
 



Making a Data Disc with the RecordNow Wizard 
You can create a data CD-ROM/DVD-ROM disc that can be read on any standard PC running a 
Windows operating system.  Long file names (up to 110 characters) will be preserved. 
 
To make a data disc: 

• Launch the Stomp RecordNow MAX Wizard. 
• Click on Make a Data Disc.  The RecordNow Wizard automatically opens your CD/DVD 

recorder’s tray. 
• Insert a blank disc into your recorder and click Next. 
• Select the files you wish to copy to CD/DVD using one of the following methods: 

- Click Add Files and Folders.  Navigate Desktop to find the file or folder you wish to 
copy.  Highlight the folder and click the Add button. 
 

 
 

- Drag and drop files or folders directly from Windows Explorer to the RecordNow Wizard 
screen. 
You can remove files of folders by highlighting the file or folder and clicking the Remove 
button.   

• You can name your disc by single clicking once on the Volume Label text in the main 
window. 

• Once you have completed selecting files, click Next and the recording process will begin. 
If you would like to make another copy of your data CD/DVD, remove the newly recorded 
disc from the recorder’s tray and insert another blank disc, then click Make Another. 

• Click Done when you have finished recording. 
 

 



Using The RecordNow MAX Full Application    
 
The RecordNow MAX Full Application gives you full control over CD/DVD projects that you 
create.  Here you can create advanced format discs such as Video CD, Mixed Mode, and CD 
Extra discs.  In the full application you have access to WarpDrive, which allows up to 64 CD 
recorders or up to 16 DVD recorders to be used simultaneously.  Also in the full application you’ll 
find a host of tools to help you get the most out of your CD/DVD recorder. 
 
Exploring the Full Application  
To enter the RecordNow MAX Full Application, simply click the Return To RecordNow MAX 
button on the bottom of the RecordNow MAX Wizard.  At first, the full application window looks a 
little empty, but that is because there is no job open yet.  The screen is broken down into 3 
sections:  Drive Status Window, Job Setup Window, and Job Status Window.  All 3 windows 
can be re-sized to fit your preferences. 
 

 
 
Drive Status Window - The Drive Status Window lists all of the drives attached to the system. 
The standard display in the Drive Status Window is a list of the drives available for reading and 
recording with a small icon to the left of the drive description and drive status displayed next to 
the drive title. Selecting Drive Large Icons from the View menu changes the display to large 
icons. The large icons provide a less cluttered display but do not display drive status during 
operations. Selecting Drive Details reverts to the standard drive list. Columns can be 
repositioned and re-sized in the drive details display by the drag and drop of column headings 
and sliding of column dividers. 
 
During various operations, a message is displayed in the standard display status column 
indicating what is happening to each drive (loading, unloading, ejecting, recording, testing, 
reading, etc). In addition, right-clicking on the drive icon will open a control panel that allows the 
drive to be loaded and unloaded, its tray opened/closed, etc. This panel can be used as an 
alternate access to the Disc Explorer to analyze a recorded disc that has been loaded into the 
drive, and to select a drive as a recorder (or reader) assigned to a job. 



Job Set Up Window -  The Job Setup Window is the space where the Job Setup Panel for each 
job is displayed. Job Setup Panels are opened by clicking on the appropriate "new" job type from 
the File pull-down menu or by clicking on a job type from the toolbar. Each time a new job is 
opened, a new panel appears in the Job Setup Window. Up to 64 job panels may be opened in 
Windows NT, 2000, or XP and up to 16 using Windows 98. These panels may be resized, and 
can be relocated by clicking on the panel's title bar and dragging. The physical arrangement of 
the panels in the Job Setup Window can be selected from the Window menu. The title bar of 
each Job Setup Panel contains the job number and job title. When the job panel is first opened, 
the job assigned a job number and an interim title which has the form "<JOB TYPE> 
UNTITLEDn", where n is the number of the job that has been newly opened since starting the 
program. (The value of n keeps incrementing even if some earlier jobs are deleted.) Do not 
confuse the arbitrary number n (used to make the titles distinct) with the job number (used to 
identify jobs in the  Job Status Panel). If jobs are deleted, any new jobs are assigned job numbers 
made available by the deleted jobs. 
 
Individual Job Setup Panels may be saved - click on the job (bring to front and highlight), then 
select File: Save Job; if the job has not already been saved (or loaded from a previously saved 
job), a dialog box will open allowing entry of a file name and path under which the Job Setup 
Panel will be saved. (If the job was previously saved, File: Save Job... will replace the job file 
without dialog.) If the job has already been saved and you wish to save it under a different name, 
select File: Save Job As (Re-name)...; the job saving dialog box will open allowing a new file 
name to be specified. 
 
When a job panel is saved, the file name will become the new job title and will be displayed in the 
title bar of the Job Setup Panel. A previously saved job may be loaded into the Job Setup 
Window by selecting File: Open Job; a dialog box will open from which stored job files may be 
selected. 

   
Tool bar  

 
 
The RecordNow MAX Full Application Tool Bar is the same for each type of job opened.  Here 
are the functions on the tool bar, their names will appear as you mouse over a button: 
RecordNow MAX Wizard -  Clicking this button will return you to the RecordNow MAX Wizard 
New Disc to Disc Copy -  This button will open a new Disc-to-Disc copy job 
New Global Image or Other Image – This button will open a Global Image or ISO  
 Image recording job (you must already have the image file built) 
New Data Disc – Opens a new data CD-ROM job 
New Audio Disc – Opens a new audio CD job 
New Mixed Mode or CD Extra Disc – Opens a new Mixed Mode or CD Extra job 
New Video CD - Opens a new Video CD job 
DVD Video – Launches your installed DVD Video Authoring application from MedioStream or 
Cyberlink 
Open – Opens a saved job 
Save – Saves an open job 
Drive – Opens the Disc Explorer & Drive Properties utility 
 
 
Pull Down Menus – The following Pull Down Menus are standard in the RecordNow MAX Full 
Application.  Some menu items have keyboard shortcuts. 

 
 
 



File  

 
 

RecordNow MAX Wizard – Launches the RecordNow MAX Wizard 
New Job – Starts a new job of the selected type 
Open -  Opens a saved job (Ctrl+O) 
Save -  Saves an open job  (Ctrl+S) 
Save As -  Saves an open job under a different name 
Load Workspace – Load a saved customized workspace 
Save Workspace – Save a customized workspace 
Record – Starts Recording the active job (F6) 
Pause – Pauses the active recording job (F7) 
Stop -  Stops the active Recording job (Ctrl+F7) 
Recent Jobs –Lists recent jobs 
Exit – Exits RecordNow MAX 

 
Edit  

 
Note: Edit pull down menu is not active unless a job is opened, and the below options are not 
available for every job. 
 

Paste – Pastes files that were cut or copied elsewhere (Ctrl+V) 
Add Audio Track – Add audio file into the Job Set Up screen 
Add With File Finder – Adds file using the file finder feature 
Add Track From CD – Adds an audio track from another CD 
Move Up – Moves a selected file up in the list (-) 
Move Down  Moves a selected file down in the list (+) 



Remove – Removes a selected file from the list 
Remove All – Removes all the files from the list 
Pre-gap and ISRC – Edits silence gap between audio tracks and adds ISRC code to selected 
audio track (track must be selected first) 
Play – Launches Media Player or other application to play  
    Selected audio file 
Recording Options -  Edit the recording options for the job 
CD Text Information View & edit CD Text information  
    Audio disc job 
Refresh – Refreshes the display (F5) 

 
 

Drive 

 
Note: A Drive must be selected (highlighted) in the Drive Status Window for this menu to be 
active. 
 
Disc Explorer & Drive Properties – Launches the Disc  
 Explorer & Drive Properties for the selected drive (F4) 
Build Global-Image – Builds a Global-Image file from a CD 
Extrack Track(s) – Extracts (rips) CD tracks into MP3 or WAVE file 
Show – Shows contents or properties of a selected disc 
Open Tray/Eject – Opens the tray/ejects the disc in the  
 Selected drive 
Close Tray – Closes the tray on the selected drive.  Has no  
 Function if the drive uses Caddy loading system 
Erase ReWritable Disc – Erases a CD-RW Disc (Quick or Full) 
 In the selected drive 
Select/Deselect as Reader – Selects or deselects the selected  
 Drive as a reader (source drive for CD copy) (Shift+F8) 
Select/Deselect as Recorder – Selects or deselects the selected 
 Drive as the recorder for a job (F8) 

 
View  

 
 
Toolbar -  If checked, displays the toolbar 



Status Bar – If checked, displays the Job Status Bar 
Drive Large Icons – If checked, displays Drive Large Icons  
 (toggles between Drive Large Icons and Drive Details) 
Drive Details – if checked, displays small drive icons, more  
 Details 
Reversed Drives Order – Reverses the order of the drives in the  
 Drive Status Window 
Show Job List Panel – If checked, shows the Job List Panel 
Show Log – Displays the job activity log 

 
Tools  

 
 

Re- Scan Buses – Re-scans ATAPI, SCSI, USB, and FireWire buses to detect newly 
connected device 
Global Image – Info. For information about a selected Global  
 Image file, Finder for searching your system for Global 
 Image files 
Web Browser – Launches your web browser to connect to the  
 Internet 
Launch -  Launches the following applications:  Windows 
 Explorer (Shift+F5), Windows CD Player (Shift+F6),  
 And Windows Media Player (Shift+F7) 
Tile with Explorer – Tiles the Job Setup Window on the upper  
 Half of the screen and the Windows Explorer on the lower 
 Half (Ctrl+F9) 
Un-tile – Removes the tile with Windows Explorer (Shift+F9) 
Options – Set up RecordNow MAX options (F3) 

 
Window  

 
 
Cascade - Multiple job windows will be in cascade order 
Tile Horizontally - Multiple job windows will be arranged  
 Horizontally 
Tile Vertically -  Multiple job windows will be arranged                      
 Vertically 



Arrange Icons – Cleans up the icon arrangement 
Close All – Closes all open jobs 
 
Note:  Any open jobs will be listed at the bottom of the  
  Window pull down menu 

 
Help  

 
Index – Launches the HTML help index (F1) 
Disc Representation Color Legend – Displays the color coding of various CD & DVD disc 
types 
Gracenote/CDDB – Connects to the Gracenote/CDDB Music Identification service 
Technical Support on the Web – Connects to Stomp’s support site on the Internet 
Product Udates via the Web – Connects and searches for product updates on the Internet 
About -  Lists important information about RecordNow MAX 
 Including version and build information 

  
Making a Disc-to-Disc Copy  
 

 
 
Using the disc-to-disc copy function in the RecordNow MAX Full Application accomplishes the 
same basic feat as using the Wizard, but with a few more options.  In the full application you have 
access to Warp Drive which allows the copy job to be made with up to 64 CD recorders or up to 



16 DVD recorders simultaneously.  In addition, you can perform a bit-for-bit “verify” of a disc(s) 
after it has been created to ensure its been faithfully copied.  You can also specify the number of 
copies to make of the disc.   If you select more than one and you’re not using Warp Drive, when 
the first disc is created, RecordNow MAX will ask you to insert another blank disc until all the 
copies have been made. 
 
Tip:  If you think you’ll have need to copy the same CD/DVD in the future, you may want to build 
a Global image of the disc.  This function preserves the original CD/DVD in an image file, 
complete with disc geometry, for later duplication.  To build a Global Image of a disc, right click 
on the icon of the drive that has the disc you’d like to make a Global Image of and select Build 
Global-Image from the menu. 
 
• From the Tool Bar, click the New Disc to Disc Copy button, or from the File pull-down menu 

select New Job -> Disc to Disc Copy.  From your keyboard you can also type Shift+F1 to 
start a new copy job 

• Your CD/DVD recorder should automatically be set as a Recorder (Red arrow pointing to it) 
and your CD-ROM/DVD-ROM drive should be set as a Reader (blue arrow pointing away 
from it).  Right click on a drive icon and use the Select/Deselect buttons if needed to 
change Reader or Recorder to the proper drive if you have more than 1 Reader and 
Recorder 

• Place the source disc to be copied into the Reader 
• Place a blank disc to be recorder into the Recorder 
• Set the number of copies you would like to make of the disc, and set the recording speed 

(default is MAX) 
• You can choose to Test & Record (default), or Test Only, Record, Test/Record/Verify, 

Record & Verify, or Verify Only. 
• Click the red record button to start the copy 
 
 
If you have only a CD or DVD burner in your system, the drive can be selected as both the reader 
and recorder.  In this case, the source CD or DVD must first be read to the hard disk, and then 
ReocordNow MAX will eject the disc and prompt you to insert a blank recordable disc for burning. 
 

 



 
 
Note:  Warp Drive can be engaged to record up to 64 copies at a time.  Simply highlight 
additional CD/DVD recorder drives in the Drive Status Window that you want to commit to the job, 
right click and then click Select/Deselect As recorder.  RecordNow MAX will display the number 
of recorders selected for the job.  You’ll need to set the number of copies that correspond to the 
number of drives you have selected as Recorders. 
 
Creating a Disc From Global Image or Other Image File 
 

 
 
Global Images are a way to preserve a CD/DVD that you want to copy in the future.  While many 
programs can “save” a disc into an image file, they usually only copy the data.  Global Images 
capture not only the data but the disc geometry as well.  In this way, an “exact copy” of the disc is 
saved.  To learn how to build a Global Image of a CD or DVD, please see Building Global 
Images 
 
• From the Tool Bar, click the New Global-Image or Other Image button, or from the File pull-

down menu select New Job -> New Global-Image or Other Image.  From your keyboard 
you can also type Shift+F2 to start a new Global Image job 

• Your CD/DVD Recorder should automatically be selected as a Recorder (red arrow pointing 
to it).  To change drives, right-click on the desired drive icon and click on Select/de-select as 
Recorder.  You’ll need to right click on the other drive and do the same to de-select it. 

• Use the Select Image File button to select the image file you want to record to disc, or use 
the handy Select Image File With File Finder button to scan your system for Global Image 
files. 

• Select the number of copies you’d like to make from the selected image file 
• Select the Speed for the recording (default is MAX.) 
• You can choose to Test & Record (default), or Test Only, Record, Test/Record/Verify, 

Record & Verify, or Verify Only 



• Insert a blank disc into the Recorder and press the red record button 
 
Note:  Warp Drive can be engaged to record up to 4 image copies at a time.  Simply highlight 
additional CD/DVD recorder drives in the Drive Status Window that you want to commit to the job, 
right click and then click Select/Deselect As recorder.  RecordNow MAX will display the number 
of recorders selected for the job.  You’ll need to set the number of copies that correspond to the 
number of drives you have selected as Recorders. 
 
 
Creating a Data CD-ROM or DVD-ROM 
 

 
 
RecordNow MAX gives you tremendous flexibility to create data CD-ROMs and DVD-ROMs.  CD-
ROM/DVD-ROMs can be very simple or very complex, depending on what you are trying to do.  
Many of the options RecordNow MAX offers won’t apply for all projects, but all the tools are 
explained just in case. RecordNow MAX can also create a Bootable CD-ROM from a floppy boot 
image file or other bootable image on your hard drive.   
 
The file system used by Windows 95 and beyond is called “Joliet” and can handle file names up 
to 110 characters.  Prior to Windows 95, most CD-ROMs used a file system called ISO9660.  
ISO9660 had limitations about how many characters a file name could contain, up to 8 characters 
followed by a 3 character extension (8+3) just like DOS.  The advantage was that ISO9660 discs 
were “cross platform” meaning Apple Macintosh and PC computers could read the disc.  
RecordNow MAX defaults to the Joliet file system, but it can be changed in the Data Job 
Options screen (click the Options button in the data CD job window). 
 
RecordNow MAX can create Single or Multi-Session discs.  Single Session means that the disc is 
recorded to just one time and then “closed” for further recording.  Multi-Session discs on the other 
hand can be added to until the disc is full, and is the default for RecordNow MAX.  By default, the 
“load last track” option is selected in the Job Set Up Window, which means the CD-ROM is 



“appended” so that all the sessions that have bee recorded are seen as one logical disc by 
Windows.  When you view or explore a multi-session CD-ROM that has been appended, you’ll 
see all the files and folders that have been added to the disc.  It is possible to make a multi-
session disc where each session is a “New Volume” meaning only the data recorded in the most 
recent session will be viewable because the sessions are not appended together. 
 
 

• From the Tool Bar, click the New Data Disc button, or from the File pull-down menu 
select New Job -> New Data Disc.  From your keyboard you can also type Shift+F3 to 
start a new data CD job 

 
Setting Data CD Job Options 
 

 
 
 
Clicking on the  Options button in the Job Set Up Window brings up the Data Job Options.  
 
Pre-Mastering Cache -  If the project is going to contain thousands of small files, then its a good 
idea to have a cache enabled.  No cache is set by default, but you can choose to “Cache All 
Files” or “Smaller than..” in which case you can drag the slider bar to determine what size files 
you will cache.  Generally if there are going to be thousands of small files (under 1 Kilobyte), set 
the Smaller Than.. option and leave the slider at 1K. 
 
Mode -  RecordNow MAX can record in standard Mode 1 or Mode 2 XA.  Mode 1 is used in 
almost every circumstance except advanced format discs such a CD Extra or Video CD 



(explained later).  Unless you’re sure you want to make a Mode 2 disc, its best to leave this 
setting alone. 
 
Recording Type (CD & DVD) -  RecordNow MAX supports all major recording modes, but not all 
CD/DVD recorders will support these options.  If you are going to be making a Multi-session, 
appendable disc, don’t change the default.  If you wish to make a Single-Session Disc, select 
“Disc-at-Once Closed” or “Track-at-Once Closed” if your drive doesn’t support Disc-at-Once.   
 
File System Type (CD & DVD) -  If you are going to be making a disc that will be played back 
within Windows, then you don’t need to change this setting.  If you’re going to be making a disc 
that you want readable in a Macintosh, then set ISO Level 1.  Keep in mind that this won’t make a 
Windows application run in a Macintosh environment, but the files/folders will be readable.  Use 
ISO Level 2 or ISO Level 2 Long if you’re sure you want to (you know who you are). 
 
If you are creating a DVD-ROM, its generally best to leave the default.  This will create a “triple 
tree” file system with Windows Joliet, UDF, and DOS 8+3 paths.  This way the DVD-ROM disc 
will be readable by a wide range of systems. 
 
Tip:  Selecting ISO Level 1 or ISO Level 2 file systems mean the file names may be “truncated” to 
fit the 8+3 rule.  This will sometimes cause the applications/programs on the disc not to function 
as the file names may now be different from what the application/program was expecting.  Use 
this feature with caution! 
 
Primary Volume Descriptor (PVD) -  You can let the files and folders in your project display the 
original date & time they were created, or set all the dates and times to be the same. 
 
Publisher ID -  Optional field if you want to put your name/company name, etc. 
 
Data Preparer  – Optional field if you want to put your name/company name, etc. 
 
Application ID -  Optional field for Application ID 
 
Bootable CD (For creating a bootable CD only) – Selects the type of boot image go be used in 
creating a bootable CD, from a floppy image, or other boot image 
 
Boot Image – Browse and select where the boot image is located 
 
Create Image -  This button will allow you to create a boot image from files on your hard disk 
 
 
• Your CD/DVD recorder should automatically be selected as a recorder (red arrow pointing to 

it).  To change drives, right-click on the desired drive icon and click on Select/de-select as 
Recorder.  You’ll need to right click on the other drive and do the same to de-select it. 
• Drag & Drop files and folders that want to record on the CD-ROM/DVD-ROM into the Job 

Set Up Window.  You can also use the Add Folder and Add File buttons to add files & 
folders.  To remove files/folders from the list, select the files/folders and click the Delete 
Selected Entries button (red X) 

 
Note:  You can change the desination location of a file/folder on the fly by double clicking on the 
file/folder after it has been added into the Job Set Up Window.  The destination can be the 
original Full Path, Partial Path, or in the Root Directory of the finished disc. 
 

• Once all the data has been added to the job and the paths set, you can give the CD-
ROM/DVD-ROM a name by entering it in the Volume label. A~Z & 0~9 characters can 



be entered, no spaces between words.  Words can be separated with an underscore ( _ 
).  Example: My_Project.  Default volume label is the date and time the CD was created.  
The buttons to the right of the volume label will reset this default volume name. 

• Select the number of copies you’d like to make from the selected data disc job 
• Select the Speed for the recording (default is MAX.) 
• You can choose to Test & Record (default), or Test Only, Record, Test/Record/Verify, 

or Record & Verify 
• Set  Multi-Session to the appropriate setting if needed.  Default is “Load Last Track if 

Any” which will append sessions together.  If you want each session to be a “standalone” 
volume, select “New Volume” in Multi-Session. 

      Remember:  If you selected to make a Disc-at-Once Closed or Track-at-once Closed 
in the “Data Job Options” You will need to set Multi-Session to “New Volume” 
• Insert a blank disc into the recorder, or an appendable Multi-Session CD/DVD that has 

already been recorded by RecordNow MAX Wizard or Full Application. 
• Press the red record button to start the recording 

  
Note:  Warp Drive can be engaged to record up to 64 discs at a time.  Simply highlight additional 
CD/DVD recorder drives in the Drive Status Window that you want to commit to the job, right click 
and then click Select/Deselect As recorder.  RecordNow MAX will display the number of 
recorders selected for the job.  You’ll need to set the number of copies that correspond to the 
number of drives you have selected as recorders. 
 
Creating an Audio CD 
 

 
 
The RecordNow MAX Full Application gives you increased options for recording audio CDs as 
well.  You can add CD Text information to your audio compilation, use Warp Drive to make 
several copies at once, and even perform verification of the finished CD. 
 



Tip:  Its better to use CD-R discs when creating audio CDs if you intend to play them on a home, 
car, or portable stereo.  Consumer CD players typically can’t play a CD-RW disc.  CD-RW audio 
discs, however, can typically be played back on your computer’s CD-ROM/DVD-ROM drive. 
 
• From the Tool Bar, click the New Audio Disc button, or from the File pulldown menu select 

New Job -> New Audio Disc.  From your keyboard you can also type Shift+F4 to start a 
new audio CD job 

• Your CD/DVD recorder should automatically be selected as a recorder (red arrow pointing to 
it).  To change drives, right-click on the desired drive icon and click on Select/de-select as 
Recorder.  You’ll need to right click on the other drive and do the same to de-select it. 

• Drag and drop MP3, WAV, and WMA files from your hard disk, or drag & drop CD tracks from 
an audio CD into the track list.  You can also add files by clicking on the Add Audio File 
button, or by using the Add With File Finder feature that will scan your hard drive for all 
MP3, WAV, and WMA files.  You can also use the Add Track From Another Audio CD 
button to add CD tracks to the track list..  Click the Refresh button to refresh the display if it 
doesn’t update automatically. 

• The order in which the files are listed in the track list are the order they will play on the 
finished CD.  You can move songs up or down in the track list by selecting them and then 
clicking on the Move Up The Selected Track and Move Down the Selected Track buttons.  
You can delete tracks from the compilation by selecting the tracks and clicking the Delete 
Selected Tracks button 

• Click the Recording Options button if you would like to change from Disc-at-Once recording 
(Default) to Track-at-Once Not Closed, or Disc-at-Once Not Closed (Session at Once)   

 
Tip:  Unless you’re sure, its best to leave the default Disc-at-Once. Creating a CD Extra disc is 
about the only reason you would want to change this setting.  If you are attempting to create a CD 
Extra disc, please see the Creating Mixed Mode and CD Extra Discs section. 
 
Audio Job Options 
 

 
 
Clicking on the Options button in the Audio Job setup window brings up the Audio Job Options 
window.  Here you can select the Recording Type (Disc-at-Once, Track-at-Once, or Session-at-
Once).  You can also add a UPC code if you desire, and enable Pre-Emphasis.  Note:  Modern 
CD players will not need any pre-emphasis, however if you are expecting to play back the disc on 
an old CD player (made before 1985) you should enable Pre-Emphasis or the disc may play back 
with the volume softer than expected. 
 
Tip: Leaving a session open means there is no table of contents written on the disc.  So, this disc 
will not play back on a standard CD player until the session is closed. 
 
Adding CD Text Information 
 
CD Text allows you to enter the actual song names, performer, and composer for the Disc and 
each track.  During playback on a compatible player, you’ll see the song names and artists 
displayed instead of the usual “Track 1, Track 2”, etc.  To use CD Text, your CD recorder must 
support this function.  To find out if it does, select the drive in the Drive Status Window and “right 
click” the mouse.  Select Disc Explorer and Drive Properties.  If your CD recorder can write CD 
Text, you will see “CD Text read/write” in the drives details on the top of the window.  



Furthermore, discs recorded with CD Text will only display CD Text information when  played 
back on players that display the CD Text logo.  The audio will playback just fine on a non-CD Text 
player, you just won’t see the artist information displayed. 
 
To add CD Text information to your compilation, click the CD Text button in the Job Set Up 
Window (abc button).   
 

 
 
Click on the Disc field and click Edit 
 

 
 
 Enter the disc information (note:  Title & Performer are mandatory, composer is optional).  If you 
want this information to be used for all the tracks, click the appropriate boxes next to Title, 
Performer, and Composer.  Click OK when done.  Repeat the same steps for each track in the 
compilation. 
 
Note:  If you’ve added CD Text information for one track, you must add it for every track on the 
disc (including the Disc information).  Also, in Recording Options it must be set for Disc-at-
Once Closed. 
 
Note: Only CD players that display the CD TEXT logo will be able to display the CD TEXT 
information.  Non-CD TEXT players will be able to play the disc normally, but you’ll see the 
Normal “track 1, track 2,” etc on the CD player’s display. 
 
Editing Pre-Gap & ISRC 
 
You can alter the silence gap between audio tracks from 0 to 9 seconds providing you are 
recording in Disc-at-Once mode.  The default is 0 seconds between tracks.  To alter the silence 
pause, select an audio track, and then click the pre-gap and ISRC button in the job setup 
window. 
 



 
 
Pre-gap must be entered in CD sectors.  1 second = 75 sectors, 2 seconds = 150 sectors, 3 
seconds = 225 sectors, and so on.  You can also enter a unique ISRC code for each track. 
 
Note:  If you’ve changed pre-gap information, check in Recording Options, recording must be 
set for Disc-at-Once Closed.  
 
• Once all the audio files & track have been added and edited as desired, Select the number of 

copies you’d like to make from the selected audio CD job 
• Select the Speed for the recording (default is MAX.) 
• You can choose to Test & Record (default), or Test Only, Record, Test/Record/Verify, 

Record & Verify, or Verify Only 
• Insert a blank disc into the CD Recorder and click the red record button to start the recording 
 
Note:  Warp Drive can be engaged to record up to 64 audio CD discs at a time.  Simply highlight 
additional CD/DVD recorder drives in the Drive Status Window that you want to commit to the job, 
right click and then click Select/Deselect As recorder.  RecordNow MAX will display the number 
of recorders selected for the job.  You’ll need to set the number of copies that correspond to the 
number of drives you have selected as recorders. 
 
Using DJ BURN 
 

 
 
DJ Burn allows you to record a standard audio CD that will be playable in standard CD players 
from a number of different sound sources, and by adding tracks one at a time.  DJ Burn lets you 
record from MP3/WAV/WMA files, tracks directly from another CD, or even live recording through 
your PC’s sound card.  You don’t have to record all the music onto the CD at one time with DJ 
Burn.  You can add one song today, some more the following day, and so on.  The caveat 
though, is that until the CD is “finalized”, it won’t be playable on standard CD players.  This “un-
finalized” CD can be played back on your CD recorder using the Windows CD player in the 
meantime. 
 



Tip:  Its better to use CD-R discs when creating audio CDs if you intend to play them on a home, 
car, or portable stereo.  These consumer CD players typically can’t play a CD-RW disc, however 
they can typically be played back on your computer’s CD-ROM/DVD-ROM drive. 
 
• Click the DJ Burn button on the Toolbar or select DJ Burn under the Tools pull down menu 
• Your CD recorder should be selected automatically.  If you have more than 1 CD/DVD 

recorder, select which one you’d like to use 
• Insert a blank disc into the CD/DVD recorder, or an un-finalized disc that DJ burn has already 

started.  You’ll see a graphic representation of how much free space is available on the disc, 
and how many tracks are already on the disc. 

 
Recording from MP3/WAV/WMA files 

• Set the Speed you’d like to record at.  MAX is default.  If you encounter a “buffer underrun” 
error, slow down the recording speed. 

• Click the Browse button on the DJ Burn main screen.  You’ll see a dialog box for you to 
select the MP3/WAV/WMA files. You can also add MP3/WAV/WMA files using the Add with 
File Finder button 

• Select the audio files you want to record and press Open.  If this is the first file or set of files 
you’ve recorded to the disc, recording will start automatically.  If you’ve already recorded 
tracks to the disc, you’ll get a dialog box confirming the speed to record at and an opportunity 
to cancel.  

• When the recording is complete, you’ll see the tracks added to DJ Burn’s Audio Tracks On 
Disc display.  These tracks can now be played on your CD recorder only until the disc is 
finalized 

 
Recording Audio Tracks from Other CDs 
• Click the Record Audio Tracks From Other CD button.  A dialog box will open for you to 

select the CD-ROM/DVD-ROM where the source disc is, and once the correct drive is 
selected, the CD tracks will be listed in the window.  

• Select the CD track or tracks you want to copy and click Open.  DJ Burn will automatically 
test the audio extraction speed of the drive with the source disc in it, and display the safest 
recording speed to match the reading speed of the other drive.  If you don’t over-ride, 
recording will start automatically in a couple of seconds at the recommended speed. 

When the recording is complete, you’ll see the tracks added to DJ Burn’s Audio Tracks On Disc 
display.  These tracks can now be played on your CD/DVD recorder only until the disc is finalized 
 
Recording Live Audio To CD 
 
Note:  You cannot use CD-RW discs to record live audio.  Live audio records at 1X (real 
time) and the minimum CD-RW speed is 2X 
 
Note:  Your CD/DVD recorder must support 1X CD recording speed in order to record live 
audio.  Some newer recorders no longer support 1X recording 
 
• Set up the device you’ll be recording from (tape deck, microphone, CD player, etc).  Check 

your volume levels in your sound card’s set up or in Windows Volume Control. 
• Place a blank CD in your CD recorder, or an un-finalized disc that DJ burn has already 

started 
• Click the Record Live button in DJ Burn and immediately start the playback from the source, 

or start speaking into the microphone as recording starts right away.  When you’re ready to 
stop recording, click the Stop button adjacent to the Record Live button.   

 



After the stop button is pressed, in a couple of seconds a new audio track will be visible in the 
Audio Tracks On Disc display.  To add more tracks this way, simply follow the same steps 
again.  These tracks can now be played on your CD recorder only until the disc is finalized. 
 
Finalizing a DJ Burn Disc 
 
To make a CD you’ve created with DJ Burn playable in standard CD players, simply place the 
disc in the CD recorder, open DJ Burn from the Starter, and click the Finalize Disc button.  This 
process may take a few minutes, and when the disc is ejected, you can start enjoying it right 
away in your car, home stereo, etc. so long as you’ve recorded on a CD-R disc.  If you’ve 
recorded on a CD-RW disc, the CD is likely only playable on your computer’s CD-ROM/DVD-
ROM drive. 
 
Creating Mixed Mode or CD Extra Discs 
 

 
 
Mixed Mode CDs were devised as a way to combine data and music tracks on the same CD.  A 
Mixed Mode CD is a “Single-Session” CD with the first “track” being a data track, and the other 
tracks on the disc being standard audio tracks.  The downside to Mixed Mode CDs is that some 
older CD players mistake the data track for an audio track and try to play it, usually resulting in 
loud static or silence. 
 
CD Extra is another way of putting data and audio tracks on the same disc, but has a distinct 
advantage over Mixed Mode discs.  CD Extra is a “Multi-Session” disc with the audio tracks in the 
first session, and the data track in the second session.  The advantage?  Consumer CD players 
like car decks and portable stereos will only recognize the first session on a disc, so there is 
never a chance that the player will try and play the data track as sometimes happens with Mixed 
Mode discs. 
 



• From the Tool Bar, click the Mixed Mode or CD Extra  button, or from the File pull-down 
menu select New Job -> Mixed Mode or CD Extra.  From your keyboard you can also type 
Shift+F5 to start a new Mixed Mode or CD Extra CD job. 

• Your CD/DVD Recorder should automatically be selected as a recorder (red arrow pointing to 
it).  To change drives, right-click on the desired drive icon and click on Select/de-select as 
Recorder.  You’ll need to right click on the other drive and do the same to de-select it. 

• Select which type of disc you are trying to make, Mixed Mode or CD Extra 
• Drag and drop MP3, WAV, and WMA files from your hard disk, or drag & drop CD tracks from 

an audio CD into the track list (upper window).  You can also add files by clicking on the Add 
Audio File button, or by using the Add With File Finder feature that will scan your hard drive 
for all MP3, WAV, and WMA files.  You can also use the Add Track From Another Audio 
CD button to add CD tracks to the track list.  Click the Refresh button to refresh the display if 
it doesn’t update automatically. 

• The order in which the files are listed in the track list are the order they will play on the 
finished CD.  You can move songs up or down in the track list by selecting them and then 
clicking on the Move Up The Selected Track and Move Down the Selected Track buttons.  
You can delete tracks from the compilation by selecting the tracks and clicking the Delete 
Selected Tracks button. 

• Drag and drop data files and folders into the File/Folder list (lower window). 
 
• Once all the audio files & track have been added and edited as desired, Select the number of 

copies you’d like to make from the selected audio CD job. 
• Select the Speed for the recording (default is MAX.). 
• You can choose to Test & Record (default), or Test Only, Record, Test/Record/Verify, 

Record & Verify, or Verify Only. 
• Insert a blank disc into the CD/DVD recorder and click the red record button to start the 

recording. 
 
Note:  Warp Drive can be engaged to record up to 64 Mixed Mode or CD Extra discs at a time.   
Simply highlight additional CD/DVD recorder drives in the Drive Status Window that you want to 
commit to the job, right click and then click Select/Deselect As recorder.  RecordNow MAX will 
display the number of recorders selected for the job.  You’ll need to set the number of copies that 
correspond to the number of drives you have selected as recorders. 
 



Creating a Video CD  
 

 
 
Video CD was the predecessor to modern day DVD Video Discs.  Video CDs are able to hold a 
movie and playback on Video CD players and many DVD Video players, but the quality is not as 
good as DVD.  The reason for this is Video CD uses the MPEG-1 encoding standard, which is 
lesser quality than MPEG-2 standard used in DVD.  As DVD recorders are still rather pricey, 
Video CD is an option to put your home video on a disc and share with family and friends who 
have compatible DVD players. 

 
Note:  MPEG-1 files to go on a Video CD need to be “formatted for Video CD according to the 
following standards: 

NTSC 352 x 240 @30Hz  (for United States) 
PAL 352 x 288 @25Hz  (for most of Europe) 
Film 352 x 240 @30Hz 
Audio inside the MPEG-1 file should be 44Khz. 
 

Several manufacturers offer formatting tools and capture boards that will save captured video to 
MPEG-1 specifically for Video CD creation.  For capture boards and software, we recommend 
Dazzle Multimedia (www.dazzle.com).  To convert MPEG-1 files that you currently have to Video 
CD form, try out XingMPEG (www.xingtech.com) 
 
• From the Tool Bar, click the New Video CD button, or from the File pulldown menu select 

New Job -> New Video CD.  From your keyboard you can also type Shift+F6 to start a new 
Video CD job 

• Your CD/DVD recorder should automatically be selected as a Recorder (red arrow pointing to 
it).  To change drives, right-click on the desired drive icon and click on Select/de-select as 
Recorder.  You’ll need to right click on the other drive and do the same to de-select it. 



• Drag & Drop formatted MPEG-1 files into the Job Set Up Window.  You can also add files by 
clicking the Select Video File button or the Video File Finder button which will search for 
MPEG-1 files on your system 

• The order in which the MPEG-1 files are listed in the Job Set Up Window are the order they 
will play on the finished Video CD.  You can move the video files up or down in the track list 
by selecting them and then clicking on the Move Up The Selected Track and Move Down 
the Selected Track buttons.  You can delete tracks from the compilation by selecting the 
tracks and clicking the Delete Selected Tracks button 

• Select the number of copies you’d like to make of the Video CD 
• Select the Speed for the recording (default is MAX.) 
• You can choose to Test & Record (default), or Test Only, Record, Test/Record/Verify, 

Record & Verify, or Verify Only 
• Insert a blank disc into the CD/DVD recorder and click the red record button to start the 

recording. 
 
Note:  Warp Drive can be engaged to record up to 64 video CD discs at a time.  Simply highlight 
additional CD/DVD recorder drives in the Drive Status Window that you want to commit to the job, 
right click and then click Select/Deselect As recorder.  RecordNow MAX will display the number 
of recorders selected for the job.  You’ll need to set the number of copies that correspond to the 
number of drives you have selected as recorders. 

 
Creating DVD Video Discs 
 
RecordNow MAX cannot create DVD Video discs directly from your camcorder or from VHS tape.  
RecordNow MAX can create a DVD Video disc from an authored DVD Video file.  To do this, 
create a Data disc, and drag and drop (or use the add files/folder button) to select the folder with 
the authored DVD Video image files.   
 
If you have DVD Video Authoring software installed in your system, a DVD Video button will 
appear on the toolbar of the RecordNow MAX Full Application.  This will allow you to launch your 
authoring software from within RecordNow MAX. 
 
If you do not yet have DVD Video Authoring software, Stomp recommends MedioStream’s 
neoDVD software.  This software will allow you to easily transfer your video footage from 
camcorder to DVD Video, or Video CD.  You can also take you MPEG, AVI, Quick Time, and DV 
files and create a DVD Video or Video CD using neoDVD.  The resulting DVD Video or Video CD 
disc will be playable in your home DVD player (note:  Some DVD players can’t read recordable 
CD or DVD media, check with your DVD player’s manufacturer for additional information). 
 
You can get a trial version of neoDVD by visiting www.mediostream.com  
 



RecordNow MAX Tools 
 
Using WarpDrive  
 
Warp Drive is an innovative way to turn up to 64 CD recorders or up to 16 DVD recorders into a 
low cost duplication system.  Warp Drive allows one job to run across multiple drives, or have 
multiple jobs open running on different recorders.  Warp Drive can be used with all jobs in the 
RecordNow MAX full application. Warp Drive can also be used for certain utility duties as well.  
For example, you can erase up to 64 CD-RW discs at a time. 
 
Note:  Warp Drive is designed to assist you in duplicating material that you have 
rights to reproduce.  BEFORE COPYING ANYTHING ONTO A CD or DVD DISC 
PLEASE BE SURE YOU ARE NOT VIOLATING COPYRIGHT LAWS.  MOST 
SOFTWARE COMPANIES ALLOW YOU TO MAKE A BACK-UP OR ARCHIVE 
COPY OF SOFTWARE.  CHECK YOUR SOFTWARE’S LICENSE AGREEMENT 
FOR SPECIFIC DETAILS.  CONTACT YOUR LEGAL ADVISOR IF YOU ARE 
UNSURE OF YOUR RIGHTS. 
 
Using Warp Drive to make Multiple Copies of a Job 
 

 
 
Using Warp Drive to make multiple copies of a single job is very simple.  When a CD copy, Global 
Image, Data CD, Audio CD, Mixed Mode/CD Extra, or Video CD job is open, simply select the 
drives you want to record to by highlighting the drives & clicking Select/Deselect As recorder 
button (red arrow).  To un-commit a recorder from a job, simply select the CD/DVD recorder(s) 
and click the select/deselect as recorder button again.  You will need to set the number of copies 
that correspond with the number of recorders you have selected. 
 



Using Warp Drive to run Multiple Jobs 
 
Warp Drive can also be used to run multiple jobs at the same time.  For example, you can start a 
Data CD job, assign one or more recorders to it, and start recording; then start a new Audio CD 
job, assign one or more recorders to it, and start, etc.  When a CD/DVD recorder is “assigned” to 
a job, it becomes unavailable (white arrow pointing to it) to other jobs that are opened. 
 
Tip:  Running multiple jobs simultaneously is system resource intensive.  It is advisable to utilize 
SCSI CD/DVD drives connected to busmastering SCSI host adapters, USB 2.0, or IEE1394 
CD/DVD drives.  Use of USB 1.1 drives is strongly NOT ADVISED.  300Mhz or faster PC is 
strongly advised as well. 
 
Disc Explorer & Drive Properties  
 

 
 
The Disc Explorer & Drive Properties utility provides a graphical interface to get drive details, 
explore a CD in any CD drive attached to the system, and perform certain tasks such as ripping 
audio tracks, building Global Images, and drive diagnostics.  The Disc Explorer & Drive 
Properties utility can be launched from Full Application only.   
 



Ripping (extracting) Audio Tracks as MP3 or WAV files  
 

 
 
The RecordNow MAX Disc Explorer & Drive Properties utility can “extract” or “rip” tracks from 
an audio CD and save them as MP3 or WAV files for recording onto CD.   Audio extraction 
can be from a CD recorder drive or CD-ROM/DVD-ROM drive.  WAV files will yield the 
highest quality as they are not compressed. In the case of MP3s, there are 5 quality levels 
that can be selected, 96, 128, 192, 256, or 320 Kb/sec.  The higher the number, the higher 
the quality and hard disk space needed. 
 

• Select the drive you want to extract from in the Drive Status Window and Right Click your 
mouse.  Select Extract Track(s) from the pop up menu.  You can also select the drive you 
want to extract from and select Extract Track(s) from the Drive pull down menu. This will 
launch the Disc Explorer and Drive Properties screen. 

• Insert the audio disc you would like to extract tracks from into the selected drive.  In a 
moment, you will see a graphical display of the disc and list of tracks on the disc.  If the 
selected drive supports CD Text reading you can click the CD Text button and the track 
display will change to display CD Text information. 

• Select the audio track you would like by clicking once on it. 
• Click the Extract Track button 
• The Extract Track panel will come up.  Click on the “ …” button if you want to specify where 

to save the file (path).  You can set the extraction speed if desired (MAX. is default) 
• Select the type of file to extract to (WAV or MP3.  If you’re ripping to MP3 you’ll need to 

select the quality of MP3 to be ripped) 
• Click Extract to begin the extraction.   
 



Building Global Images  
 

 
 
A Global CD image is a way to preserve a CD/DVD for future duplication by extracting the 
data on the disc along with all the disc geometry that is stored in the discs TOC (Table Of 
Contents) into an image file.  This is the only way to produce an image file that is “exactly” 
like the original disc.  RecordNow MAX provides for recording a CD/DVD from a Global 
Image file in the Full Application, reproducing the CD that was used to build the image.  
Global Image files can be created from just about any CD/DVD format. 

 
Note:  You will need the same amount of hard disk space as the size of the CD/DVD you’re 

going to create the Global Image file from.  For example if the source is a CD 500Mb in size, 
you’ll need 500Mb of available hard disk space to hold the Global Image file.  
 
To build a Global Image file from a CD or DVD: 

 
• Launch the Disc Explorer & Drive Properties utility in the Full Application. Click on the Drive 

button on the Toolbar, or select the drive you want to build the image from in the Drive 
Status Window and Right Click your mouse.  Select Disc Explorer & Drive Properties from 
the pop up menu.  And finally, you can also launch the utility by simply pressing F4 on your 
keyboard. 

• Insert the disc you would like to build a Global Image from into the selected drive.  In a 
moment, you will see a graphical display of the disc and list of tracks on the disc.  

• Click the Global Image button  
• The Global Image panel will come up.  Give the Global Image a name, and if desired, use the 

“browse …” button to select the location to save the Global Image file to.  You can set the 
speed to build the Global Image if desired (MAX. is default) 

• Click the Build button to start building the Global Image. 
 



Testing Audio Extraction speed  
 

Disc Explorer and Drive Properties gives you the ability to measure the audio extraction speed 
and accuracy of the CD/DVD recorder or CD-ROM/DVD-ROM drive you have selected.  This is 
particularly useful if you are having difficulty performing CD to CD copies; you can find out just 
how fast your source drive can extract audio and if its 100% accurate.   
 
• Launch the Disc Explorer & Drive Properties utility. From the Full Application, you can click 

on the Drive button on the Toolbar, or select the drive you want to test in the Drive Status 
Window and Right Click your mouse.  Select Disc Explorer & Drive Properties from the pop 
up menu.  And finally, you can also launch the utility by simply pressing F4 on your keyboard. 

• Insert any audio CD into the drive to be tested 
• Click the Audio Extraction Speed Test button to start the test 
• Results will be listed at the bottom of the screen for speed & accuracy 
 
Testing Data Extraction speed  
Disc Explorer & Drive Properties can also measure the speed of data extraction from a CD/DVD 
recorder or CD-ROM/DVD-ROM drive you have selected.  This test is helpful if you’re having 
difficulty performing Disc-to-Disc copies as you’ll be able to determine the real extraction speed of 
your source drive. 
 
• Launch the Disc Explorer & Drive Properties utility. From the Full Application, you can click 

on the Drive button on the Toolbar, or select the drive you want to test in the Drive Status 
Window and Right Click your mouse.  Select Disc Explorer & Drive Properties from the pop 
up menu.  And finally, you can also launch the utility by simply pressing F4 on your keyboard. 

• Insert any data CD-ROM into the drive to be tested 
• Click the Data Extraction Speed Test button to start the test 
• Results will be listed at the bottom of the screen for speed 
 
Performing a Recorder self test 
 
The RecordNow MAX Disc Explorer & Drive Properties can perform a comprehensive test of your 
CD/DVD recorder to ensure it is functioning correctly.  This test is crucial if you suspect your drive 
is not functioning correctly. 
 
• Launch the Disc Explorer & Drive Properties utility In the Full Application. You can click on 

the Drive button on the Toolbar, or select the CD/DVD recorder you want to test in the Drive 
Status Window and Right Click your mouse.  Select Disc Explorer & Drive Properties from 
the pop up menu.  And finally, you can also launch the utility by simply pressing F4 on your 
keyboard 

• Insert a blank disc into the CD/DVD recorder to be tested (don’t worry, it will not be recorded 
on) 

• Click the Recorder Self Test button 
• After a minute or so, you will get a message if the self test was completed successfully or not.  

If the test was not successful, your CD/DVD recorder may need service 
 
Options  

 
RecordNow MAX has several options that can be set.  To get to these options, go to the Full 
Application and use the Tools pull down menu and select Options.  You can also get there by 
simply pressing the F3 key on your keyboard. 
 



General  

 
 
These are the general options that can be set to do basic things such as to play or not play 
sounds.  It is recommended to leave Disable Audio CD and CD-ROM Autorun When This 
Application is Open enabled as autorun programs can cause a buffer underrun when recording.  
Its also a good idea to enable Test Reading Speed when Coping Directly from a Disc when 
you suspect the reading drive is slow.  This will automatically set the best recording speed based 
on the audio/data extraction speed of the Reader.  You can also specify to remember settings 
and drives used in other jobs. 
 
Note:  If your CD recorder supports BurnProof, Just Link, Power-Burn, or other anti-buffer 
underrun scheme, you will see a check mark in the General options.   Recorders that don’t have 
this protection won’t show this option at all. 
 



View  

 
 
Here you can customize the views in the RecordNow MAX software.  It’s a good idea to leave the 
defaults set. 
 
Data Disc  

 
 
Here you can set the path defaults for data CD-ROM jobs.  It is recommended to leave the Check 
If Every File Is Readable Before Recording option set 
 
 



Audio Disc 

 
 
 
 
Temporary 

 
 
Here you can set the Temporary directory where RecordNow MAX places temporary files 

 
 



Blank Size (OverBurning)  

 
 
OverBurning is a technique some CD recorder manufacturers utilize to squeeze a bit more data 
onto a CD-R disc.  RecordNow MAX implements this feature on supported recorders.  To 
OverBurn, you need to manually set the size of the blank disc to “fool” the CD recorder into 
thinking the disc is larger than it is reporting. 
 
• Click the Overburn For The Following Amount circle, and fill in the amount you would like 

to try and OverBurn.  Try the default (5,000 sectors) first. 
 
Note:  Many CD recorders do not support overburning.  If performing the above “test” fails, you’ll 
know for sure if your recorder supports this function.   
 



Job/Round 

 
 
The Job/Round options panel is ideal for setting up multiple drive Warp Drive Burning.  These 
options only work for manually loaded CD/DVD recorders.  Auto-loading duplicators will ignore 
these settings. 
 
Advanced 

 
 



The Advanced options panel is useful for setting up multiple drive WarpDrive burns, for example 
you can specify to only use drives for simultaneous recording that are of the same brand, model, 
and firmware version (strongly recommended). 
 
 
Trouble Shooting  
 
Common problems & solutions 
The most common problem encountered while recording CDs is “Buffer Underrun”.   Buffer 
Underrun occurs when the recording speed of the CD recorder is faster than the data rate of the 
hard disk/CD-ROM/DVD-ROM drive supplying the data.  Once a CD recording job has been 
started, the recorder needs a consistent flow of data at the data rate required for the speed 
selected.  For example: 
 
 Recording at 1X requires steady data rate of 150 Kilobytes per second 
 Recording at 2X requires steady data rate of 300 Kilobytes per second 
 Recording at 4X requires steady data rate of 600 Kilobytes per second 
 Recording at 6X requires steady data rate of 900 Kilobytes per second 
 Recording at 8X requires steady data rate of 1.2 Megabytes per second 
 Recording at 10X requires steady data rate of 1.5 Megabytes per second 
 Recording at 12X requires steady data rate of  1.8 Megabytes per second 
 
In order to record successfully at higher speeds, your system may need some optimization.  Slow 
data transfer can be caused by a number of things: 
 

• Slow or fragmented hard disk 
Solution:  De-fragment the hard drive, or get a faster drive.   
• Applications running in background taking system resources 

Solution:  Quit open applications that use excessive system resources like email programs, 
fax programs, web browsers, screen savers, etc. 

• Slow audio/data extraction from CD-ROM/DVD-ROM 
Solution:  Use Disc Explorer & Drive Properties’ Audio & Data extraction tests to determine 
the true extraction speed the source drive can support.  Adjust the recording speed below the 
extraction speed. 

• Dirty or scratched CD or DVD media 
Solution:  Check your disc and replace if scratched.  Discs can be cleaned according to the 
manufacturers instructions.  

 
Note:  Some CD recorders support BurnProof or other anti-buffer underrun scheme which is a 
“buffer underrun avoidance” feature.  BurnProof-type drives can recover on the fly from a buffer 
underrun and continue recording, instead of making a “coaster”.  RecordNow MAX fully supports 
BurnProof in enabled drives.  To see if your recorder supports BurnProof, in the Full application 
select the drive in the Drive Status Window, then go to the Tools pull down menu => Options 
menu.  Click on General.  If you see BurnProof and its checked, then your drive supports 
BurnProof.  Non-BurnProof drives don’t display the option at all. 
 
Tip:  Always use the Recordable CD/DVD media that is recommended by your recorder 
manufacturer.  Always check to ensure the CD/DVD media supports the speed you wish to 
record at.  

 
 
 



Using DLA (Drive Letter Access) 
 
Drive Letter Access (DLA) allows you to use your CD or DVD+RW recorder just as you would any 
other drive. This means you can now write files to your optical discs, delete files from your discs, 
and even format them directly from Windows Explorer without having to use any special 
mastering software. 
DLA offers such helpful features as: 
 
• Drag and Drop files: You can drag and drop files directly from Windows Explorer to your 

optical drive. 
• Formatting discs: DLA lets you customize how you format your CDs and DVDs. You can 

perform a Quick or Full format, set what type of file system is used, and create a label for 
your disc. 

• Making discs compatible with other operating systems: With DLA’s Make Compatible feature, 
you can make CD-R discs readable by virtually any CD-ROM drive. 

• Viewing disc properties: DLA shows you information about your media with a click of a 
button. 

• Viewing disc contents: DLA uses the standard Windows Explorer screen to show you the 
contents of your disc. 

 
Starting the DLA Application for the First Time 
 

Double click on the  icon on the Windows Tool Bar (lower right hand corner of Windows).  This 
will launch the DLA application.  The DLA driver is always active, so when a DLA formatted disc 
is inserted into the burner, it will be ready for use in Windows. 
 

 
 
From the main DLA menu, you can format a blank disc for use with DLA, set preferences, and 
eject the disc from the drive.  You can also chose to make a DLA disc “compatible” which will 
allow a computer not running DLA to read the disc. 
Note:  It is recommended to always eject a DLA disc from within the DLA software 
 



Formatting A Disc 
 

• Launch the DLA application from the Windows toolbar by double clicking the  icon 
• Select Format from the main DLA screen 
 

 
 
• Insert a blank disc into the CD/DVD Burner and click Next 
 

 
 
• Give the disc to be formatted a volume label (name that will show up under Windows) and 

select to do a quick or full format.  If you wish, you can enable the compression that 
effectively doubles the storage space on the disc.  Click Next. 

 
Once the formatting is completed, the disc will be ready to store data.  Simply drag and drop files 
and folders to the DLA disc, or save to from within an application.  To delete a file or folder, drag it 
to the recycle bin. 



 
Making A DLA Disc Compatible With Other Systems 
 
• Launch the DLA application from the Windows Toolbar.  Click Make Compatible. 
 

 
 
• Click Start to begin.  Caution:  Once this process is done, the disc can’t be written to 

again by DLA unless it is re-formatted!! 
 
Caution:  If you have Adaptec/Roxio’s DirectCD installed on your system, please un-install it as it 
will conflict with the proper functioning of DLA. 
Caution:  If you have Ahead’s NERO CD mastering software installed, please un-install it as it 
will conflict with the proper functioning of DLA. 
 
Note:  If you have a USB, FireWire, or other hot swappable CD/DVD burner, please be aware 
that if the drive is un-plugged while DLA is running, it will not resume operation when the drive is 
re-connected.  If the drive is removed while DLA is running, the system will need to be re-started. 
 
 
 
 


